# Table of Contents

1 INTRODUCTION .......................................................................................................................... 5
  1.1 About This Manual ................................................................................................................. 5
    1.1.1 List of Revisions ......................................................................................................... 5
    1.1.2 Conventions in this Manual ....................................................................................... 6
  1.2 Versions of Devices, Firmware, Software Tools, Drivers and Device Description File ............. 7
  1.3 Software Package .................................................................................................................. 8
    1.3.1 Contents of the Product DVD ..................................................................................... 8
    1.3.2 How to Use the Product DVD ................................................................................... 10
    1.3.3 Notes on Installing the USB Driver .......................................................................... 11
  1.4 Documentation Overview .................................................................................................... 12
  1.5 Legal Notes .......................................................................................................................... 13
    1.5.1 Copyright .................................................................................................................... 13
    1.5.2 Important Notes ......................................................................................................... 13
    1.5.3 Exclusion of Liability ................................................................................................. 14
    1.5.4 Warranty ................................................................................................................... 14
    1.5.5 Export Regulations ..................................................................................................... 15
    1.5.6 Trademarks ................................................................................................................ 15

2 SAFETY ...................................................................................................................................... 16
  2.1 General Note .......................................................................................................................... 16
  2.2 Intended Use .......................................................................................................................... 16
  2.3 Personnel Qualification ......................................................................................................... 16
  2.4 References Safety ................................................................................................................. 16
  2.5 Safety Instructions to Avoid Personal Injury ........................................................................... 17
    2.5.1 Electrical Shock Hazard ............................................................................................ 17
    2.5.2 Danger of Unintended Starting Up of Machines ....................................................... 17
  2.6 Safety Instructions to Avoid Property Damage ....................................................................... 18
    2.6.1 General Safety Instructions Concerning Supply Voltage ......................................... 18
    2.6.2 Device Destruction by Exceeding Allowed Supply Voltage ..................................... 18
    2.6.3 Electrostatic Sensitive Device ................................................................................... 19
  2.7 Labeling of Safety Messages ................................................................................................. 20

3 DESCRIPTIONS AND REQUIREMENTS ................................................................................. 21
  3.1 Device Description EU5C-SWD-POWERLINK Gateway ....................................................... 21
    3.1.1 Function ...................................................................................................................... 21
    3.1.2 Configuration .............................................................................................................. 22
    3.1.3 Interfaces .................................................................................................................... 24
    3.1.4 Diagnosis ..................................................................................................................... 24
    3.1.5 Firmware and Device Description File ....................................................................... 24
  3.2 Prerequisites for Operation ................................................................................................... 25
# Table of Contents

## 3.2.1 Network Systems

## 3.2.2 Power Supply

## 4 DEVICE PICTURE, CONNECTORS AND LEDS

### 4.1 Device Picture

### 4.2 Positions and Meaning of the LEDs

#### 4.2.1 Positions of the LEDs

#### 4.2.2 Descriptions of the LEDs

### 4.3 Pinning POWERLINK Interface

### 4.4 Device Type Label

## 5 GETTING STARTED

## 6 INSTALLING GATEWAY

### 6.1 Safety Messages

### 6.2 Mounting Gateway

#### 6.2.1 Mounting Gateway onto Top Hat Rail

#### 6.2.2 Removing Gateway from Top Hat Rail

### 6.3 Connecting Gateway to Power Supply

### 6.4 Connecting SmartWire-DT

### 6.5 Connecting POWERLINK

### 6.6 EMC-Conformant Wiring of the Network

## 7 CONFIGURING GATEWAY

### 7.1 Configuring SmartWire-DT network in Gateway (Creating Target Configuration)

### 7.2 Installing SWD-Assist and USB Driver on Configuration PC

### 7.3 Connecting Gateway to Configuration PC via USB

### 7.4 Configuring Gateway in SWD-Assist (Creating Project Configuration)

## 8 CONFIGURING GATEWAY IN POWERLINK

## 9 POWERLINK DATA COMMUNICATION

### 9.1 Acyclical Communication

#### 9.1.1 SDO Write (Acyclic Output)

#### 9.1.2 SDO Read (Acyclic Input)

### 9.2 Diagnosis/Status Response

## 10 UPDATING FIRMWARE

### 10.1 Overview

### 10.2 IP Address of Gateway

### 10.3 Prerequisites

### 10.4 Step-by-Step Instructions for Updating Firmware

### 10.5 Resetting Gateway
Table of Contents

11 TECHNICAL DATA .............................................................................................................67
  11.1 Technical Data EU5C-SWD-POWERLINK Gateway .............................................67
  11.2 Technical Data POWERLINK Controlled Node ...............................................69

12 ANNEX ..........................................................................................................................70
  12.1 List of Figures .........................................................................................................70
  12.2 List of Tables ..........................................................................................................71
  12.3 Contacts ..................................................................................................................72
1 Introduction

1.1 About This Manual

This manual describes the Eaton EU5C-SWD-POWERLINK SmartWire-DT Gateway. Here you will find information on how to install, configure and operate the gateway.

This manual is intended for automation technicians and engineers. Detailed knowledge of Ethernet POWERLINK is presumed. In addition, readers should also be familiar with the handling of the SmartWire-DT system.

IMPORTANT!

- To avoid personal injuries or damage of electrical devices, please read this manual carefully before installing and using the EU5C-SWD-POWERLINK Gateway.
- Please first read the Safety chapter on page 16 ff.

1.1.1 List of Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Chapter</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2013-10-15</td>
<td>All</td>
<td>Created</td>
</tr>
<tr>
<td>2</td>
<td>2013-12-09</td>
<td>9.2</td>
<td>Section Diagnosis/Status Response revised.</td>
</tr>
</tbody>
</table>

Table 1: List of Revisions
1.1.2 Conventions in this Manual

Notes, operation instructions and results of operation steps are marked as follows:

Notes

Important: <important note>

Note: <note>

<note, where to find further information>

Operation Instructions

1. <instruction>
2. <instruction>

or

➢ <instruction>

Results

➢ <result>

For a description of the labeling of Safety Messages, see Labeling of Safety Messages section on page 20.
1.2 Versions of Devices, Firmware, Software Tools, Drivers and Device Description File

The hardware revisions and software versions functionally belong together. This means that certain revisions of the hardware of the gateway need certain versions of firmware, software and drivers, in order to function properly.

This section lists the hardware revisions and the versions of the firmware, the configuration software and the drivers which functionally belong together and to which all instructions in this manual refer.

Device and Firmware

This manual refers to the following hardware revision and firmware version of the EU5C-SWD-POWERLINK Gateway:

<table>
<thead>
<tr>
<th>Device type name</th>
<th>Protocol</th>
<th>Part number</th>
<th>Hardware revision</th>
<th>Firmware</th>
<th>Firmware version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EU5C-SWD-POWERLINK</td>
<td>POWERLINK Controlled Node</td>
<td>9233.921</td>
<td>3</td>
<td>E030K0U0.nxf</td>
<td>1.0.x.x</td>
</tr>
</tbody>
</table>

Table 2: Reference to Hardware and Firmware

Software Tools

This manual refers to the following software versions:

<table>
<thead>
<tr>
<th>Software</th>
<th>Manufacturer</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet Device Configuration Tool</td>
<td>Eaton</td>
<td>1.501</td>
</tr>
<tr>
<td>Automation Studio</td>
<td>Bernecker + Rainer</td>
<td>3.0.90</td>
</tr>
<tr>
<td>SWD-Assist</td>
<td>Eaton</td>
<td>1.90</td>
</tr>
</tbody>
</table>

Table 3: Reference to Software Tools

Drivers

This manual refers to the following driver versions:

<table>
<thead>
<tr>
<th>Driver</th>
<th>File name</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows USB Driver</td>
<td>usbser.sys</td>
<td>Depending on Windows version</td>
</tr>
</tbody>
</table>

Table 4: Reference to Drivers
1.3 Software Package

You need the SWD-Assist software in order to configure the EU5C-SWD-POWERLINK gateway.

The software can be ordered separately from Eaton under the product name EU5C-SWD-SW (order number 3233.920). The package contains the SmartWire-DT Gateway Solutions product DVD and a Mini-USB cable.

You can download the contents of the product DVD as ZIP file free of charge from our website www.eaton.com under Products > Gateways or under Support > Downloads.

1.3.1 Contents of the Product DVD

There is one product DVD, which can be used for several types of gateways.

The SmartWire-DT Gateway Solutions product DVD includes:

- Device description files

  **Note:** A device description file for the EU5C-SWD-POWERLINK Gateway is not provided on the product DVD. The project-specific XDD device description file for the POWERLINK-Gateway has to be generated by the SWD-Assist software.

- Firmware
- Eaton SWD-Assist software
- Wizard for installing the software available on the DVD and for downloading the latest version of the SWD-Assist software from the internet
- Installation program for USB driver (USB driver is needed for connecting the gateway to a PC in order to use the Eaton SWD-Assist software)
- Installation program for the Eaton Ethernet Device Configuration Tool
- Documentation in PDF format
- Installation program for Adobe Reader
The product DVD has the following directories:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation</td>
<td>PDF manuals in German and English and installation program for Adobe Reader</td>
</tr>
<tr>
<td>Driver</td>
<td>Folder containing installation program (setup.exe) and .INF- and .CAT- files for Windows USB driver.</td>
</tr>
<tr>
<td>EDS</td>
<td>Electronic device description files and bitmaps, to be imported directly into Master/Controller configuration software. Note: The device description file for the EU5C-SWD-POWERLINK Gateway has to be generated by the SWD-Assist software.</td>
</tr>
<tr>
<td>Firmware</td>
<td>Loadable gateway firmware</td>
</tr>
<tr>
<td>fcommand</td>
<td>Files for start screen of product DVD</td>
</tr>
</tbody>
</table>
| Software | SWD-Assist software
Folder: Software\SWD-Assist
Wizard for installing the software available on the DVD and for downloading the latest version of the SWD-Assist software from the internet
Folder: Software\Setup
Installation program for Ethernet Device Configuration Tool
Folder: Software\EnDeviceCfg |

Table 5: Directory of DVD

**Note:** You can use the wizard on the product DVD to download updates of the Eaton SWD-Assist software, or you can download SWD-Assist directly from the www.moeller.net website under **Support > Download Center**. Direct link: [http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99](http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99)

You can download other content stored on the DVD from the Eaton website [www.eaton.com](http://www.eaton.com) under **Support > Downloads**.
1.3.2 How to Use the Product DVD

Insert the SmartWire-DT Gateway Solutions product DVD into the DVD drive of your configuration PC. If the auto start function of your DVD drive is enabled, the start screen of the DVD automatically opens. You can also start the DVD by double-clicking the SmartWire.exe file in the root directory of the DVD.

In the menu of the start screen of the DVD, click Install Planning and Configuration Tools to open a wizard for installing the software programs stored on the DVD. The wizard also helps you to download the latest version of the Eaton planning software SWD-Assist from the internet. It automatically checks for already installed software components (which e.g. might have been installed for an earlier project), and lists the missing components accordingly. The following options might be offered:

- **USB driver**: installs USB driver for Windows on your PC.
- **SWD Planning Software SWD-Assist V1.90**: installs version 1.90 of the SWD-Assist software (provided on the DVD) on your PC.
- **Download Center SWD-Assist, manual update check**: connects your browser to a web page where you can download the latest version of the SWD-Assist software.
- **Ethernet Device Scanner/Configuration Tool**: installs the Eaton Ethernet Device Configuration Tool on your PC.
- **PROFINET GSDML File**: opens a link to the device description file of the EU5C-SWD-PROFINET gateway.

**Note**: A device description file for the EU5C-SWD-POWERLINK Gateway is not provided on the product DVD. The device description file for the POWERLINK gateway has to be generated by the SWD-Assist software specifically for the project.

In the menu of the start screen of the DVD, you can also open folders (directories) in which the documentation, the USB driver and the GSDML file are stored.
1.3.3 Notes on Installing the USB Driver

Before you connect the EU5C-SWD-POWERLINK Gateway via USB to your configuration PC (in order to use the SWD-Assist software), you should first install the USB driver on your PC.

To install the USB driver from the DVD, choose Install Planning and Configuration Tools in the DVD menu to open the installation wizard, and then select the USB driver option. As an alternative, you can use the Windows Explorer to open the Driver\USB\Windows folder on the DVD, and then double-click the setup.exe file. Just follow the instructions of the installation routine afterwards.

**Note:** Under Windows XP, the installation process is not yet finished by the setup. The installation process has to be completed in the Found new Hardware Wizard, which automatically opens when you connect the gateway to a PC via USB cable for the first time (see below).

### Windows XP

When you connect the gateway via USB for the first time to a PC running under Windows XP, the Found New Hardware Wizard opens:

- **Answer the question** Can Windows connect to Windows Update…?, with **No, not this time**. Then click **Next** button.
- **If you have already carried out the setup of the USB driver (as recommended), you can ignore the wizard’s request to insert a CD or floppy disk. Answer the What do you want the wizard to do? question by selecting the Install the software automatically option, then click Next button.**
- **After the installation is complete, click Finish button.**

### Windows 7 and 8

If you have carried out the setup of the USB driver before first connecting the USB cable (as recommended), then the USB connection is instantly operative under Windows 7 and 8.

### Uninstall USB Driver

If you want to remove the USB driver from a PC running under Windows XP, choose **Start** menu > **Control Panel** > **Add or Remove Programs**, then select: Windows Driver Package – Eaton Ports entry.

Click **Change/Remove** button to uninstall the driver.

Under Windows 7 and 8, choose **Start** menu > **Control Panel** > **Uninstall a program**, then select: Windows Driver Package – Eaton Ports entry.

Click **Uninstall/Change** button to uninstall the driver.
1.4 Documentation Overview

Besides this user manual at hand (path on product DVD: Documentation\english\2. Hardware\EU5C-SWD-POWERLINK UM 01 EN.pdf), the following documents are also relevant for the user of the EU5C-SWD-POWERLINK Gateway:

<table>
<thead>
<tr>
<th>Title</th>
<th>Contents</th>
<th>Publisher</th>
<th>Document ID</th>
<th>Path on product DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SmartWire-DT Units</strong></td>
<td>Information on engineering, installation and programming of the individual SmartWire-DT slaves.</td>
<td>Eaton</td>
<td>05/11 MN050060012-EN</td>
<td>Documentation\english\3.SmartWire-DT\SmartWire-DT - Units\MN050060012_EN.pdf</td>
</tr>
<tr>
<td><strong>SmartWire-DT The System</strong></td>
<td>Information on function, installation, commissioning and diagnostics of the SmartWire-DT system.</td>
<td>Eaton</td>
<td>02/11 MN050060022-EN</td>
<td>Documentation\english\3.SmartWire-DT\SmartWire-DT - The System\MN050060022_EN.pdf</td>
</tr>
<tr>
<td><strong>Ethernet Device Configuration</strong></td>
<td>Operating Instruction Manual of Eaton Ethernet Device Configuration Tool.</td>
<td>Eaton</td>
<td>DOC050402O1xxEN</td>
<td>Documentation\english\1.Software\Ethernet Device Setup Utility\ Ethernet Device Configuration OI xx EN.pdf</td>
</tr>
<tr>
<td>SWD-Assist Online help</td>
<td>Online help for SWD-Assist planning software</td>
<td>Eaton</td>
<td>-</td>
<td>Included in SWD-Assist software</td>
</tr>
<tr>
<td>B&amp;R Help Explorer – Automation Studio</td>
<td>Online help for Automation Studio software</td>
<td>Bernecker + Rainer</td>
<td>-</td>
<td>Included in Automation Studio software</td>
</tr>
</tbody>
</table>

Table 6: Documentation Overview
1.5 Legal Notes

1.5.1 Copyright

© Eaton 2013
All rights reserved.

The images, photographs and texts in the accompanying material (user manual, accompanying texts, documentation, etc.) are protected by German and international copyright law as well as international trade and protection provisions. You are not authorized to duplicate these in whole or in part using technical or mechanical methods (printing, photocopying or other methods), to manipulate or transfer using electronic systems without prior written consent. You are not permitted to make changes to copyright notices, markings, trademarks or ownership declarations. The included diagrams do not take the patent situation into account. The company names and product descriptions included in this document may be trademarks or brands of the respective owners and may be trademarked or patented. Any form of further use requires the explicit consent of the respective rights owner.

1.5.2 Important Notes

The user manual, accompanying texts and the documentation were created for the use of the products by qualified experts, however, errors cannot be ruled out. For this reason, no guarantee can be made and neither juristic responsibility for erroneous information nor any liability can be assumed. Descriptions, accompanying texts and documentation included in the user manual do not present a guarantee nor any information about proper use as stipulated in the contract or a warranted feature. It cannot be ruled out that the user manual, the accompanying texts and the documentation do not correspond exactly to the described features, standards or other data of the delivered product. No warranty or guarantee regarding the correctness or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well as related user manuals, accompanying texts and documentation at all times and without advance notice, without obligation to report the change. Changes will be included in future manuals and do not constitute any obligations. There is no entitlement to revisions of delivered documents. The manual delivered with the product applies.

Eaton is not liable under any circumstances for direct, indirect, incidental or follow-on damage or loss of earnings resulting from the use of the information contained in this publication.
1.5.3 Exclusion of Liability

The software was produced and tested with utmost care by Eaton and is made available as is. No warranty can be assumed for the performance and flawlessness of the software for all usage conditions and cases and for the results produced when utilized by the user. Liability for any damages that may result from the use of the hardware or software or related documents, is limited to cases of intent or grossly negligent violation of significant contractual obligations. Indemnity claims for the violation of significant contractual obligations are limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:

- for military purposes or in weapon systems;
- for the design, construction, maintenance or operation of nuclear facilities;
- in air traffic control systems, air traffic or air traffic communication systems;
- in life support systems;
- in systems in which failures in the software could lead to personal injury or injuries leading to death.

We inform you that the software was not developed for use in dangerous environments requiring fail-proof control mechanisms. Use of the software in such an environment occurs at your own risk. No liability is assumed for damages or losses due to unauthorized use.

1.5.4 Warranty

Although the hardware and software was developed with utmost care and tested intensively, Eaton does not guarantee its suitability for any purpose not confirmed in writing. It cannot be guaranteed that the hardware and software will meet your requirements, that the use of the software operates without interruption and that the software is free of errors. No guarantee is made regarding infringements, violations of patents, rights of ownership or the freedom from interference by third parties. No additional guarantees or assurances are made regarding marketability, freedom of defect of title, integration or usability for certain purposes unless they are required in accordance with the law and cannot be limited. Warranty claims are limited to the right to claim rectification.
1.5.5 Export Regulations

The delivered product (including the technical data) is subject to export or import laws as well as the associated regulations of different counters, in particular those of Germany and the USA. The software may not be exported to countries where this is prohibited by the United States Export Administration Act and its additional provisions. You are obligated to comply with the regulations at your personal responsibility. We wish to inform you that you may require permission from state authorities to export, re-export or import the product.

1.5.6 Trademarks

SmartWire-DT® is a registered trademark of Eaton Corporation.

Windows® XP, Windows® 7 and Windows® 8 are registered trademarks of the Microsoft Corporation.

Adobe-Acrobat® is a registered trademark of Adobe Systems Incorporated.

Ethernet POWERLINK and B & R Automation Studio are trademarks of B&R, Bernecker + Rainer Industrie-Elektronik Ges.m.b.H, Eggelsberg, Austria.

All other mentioned trademarks are property of their respective legal owners.
2 Safety

2.1 General Note

The user manual, all accompanying texts and the documentation are written for the use of the products by educated personnel. When using the products, all safety instructions, property damage messages and all valid legal regulations have to be observed. Technical knowledge is presumed. The user has to assure that all legal regulations are obeyed.

2.2 Intended Use

The purpose of the EU5C-SWD-POWERLINK Gateway described in this user manual is to create a connection between SmartWire-DT slaves and an overriding Managing Node (master device) in an Ethernet POWERLINK network.

2.3 Personnel Qualification

The EU5C-SWD-POWERLINK Gateway must be installed, configured and removed by qualified personnel only. Job-specific technical skills for people professionally working with electricity must be present concerning the following issues:

- Safety and health at work
- Mounting and connecting of electrical equipment
- Measurement and analysis of electrical functions and systems
- Evaluation of the safety of electrical systems and equipment
- Installing and configuring IT systems

2.4 References Safety

[S1] ANSI Z535.6-2006 American National Standard for Product Safety Information in Product Manuals, Instructions, and Other Collateral Materials
[S3] EN 61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2
2.5 Safety Instructions to Avoid Personal Injury

To ensure your own personal safety and to avoid personal injury, you must read, understand and follow the following safety instructions in this manual and all warning messages before you install and operate the EU5C-SWD-POWERLINK Gateway.

2.5.1 Electrical Shock Hazard

Take care of the following safety measures before installing or uninstalling the gateway:

- First disconnect the power plug of the device.
- Make sure that the device is disconnected from the power supply.
- Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets must only be operated and controlled after they have been installed with the housing closed. Desktop or portable units must only be operated and controlled in enclosed housings.

2.5.2 Danger of Unintended Starting Up of Machines

- Install automation devices and related operating elements in such a way that they are well protected against unintentional operation.
- Emergency stop devices complying with IEC/EN 60204-1 must be effective in all operating modes of the automation devices. Unlatching the emergency-stop devices must not cause restart.
- You must take safety precautions (emergency switching off) in the external circuitry of the EU5C-SWD-POWERLINK and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.
- Measures should be taken to ensure the proper restart of programs interrupted after a voltage dip or failure. This should not cause dangerous operating states even for a short time. If necessary, emergency stop devices should be implemented.
- Wherever faults in the automation system may cause damage to persons or property, external measures must be implemented to ensure a safe operating state in the event of a fault or malfunction (for example, by means of separate limit switches, mechanical interlocks etc.).
2.6 Safety Instructions to Avoid Property Damage

To avoid damage to your EU5C-SWD-POWERLINK Gateway or your communication system, you must read, understand and follow the following safety instructions and all safety instructions and warnings in this manual concerning property damage, before you install and operate the gateway.

2.6.1 General Safety Instructions Concerning Supply Voltage

- In safety-relevant applications the power supply providing power to the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).
- Switch off the power supply if you are reconnecting slaves in the SmartWire-DT system or reconnecting the ribbon cable connection. Otherwise the SmartWire-DT slaves can be destroyed!
- The gateway has protection against polarity reversal for the 24-V-DC-POW supply. However, if the gateway is connected via the serial interface to an earthed device (for example to a PC), the gateway can be destroyed, if the polarity of the power supply is reversed!
- The functional earth (FE) must be connected to the protective earth (PE) or to the potential equalization. The system installer is responsible for implementing this connection.
- Connecting cables and signal lines should be installed so that inductive or capacitive interference does not impair the automation functions.
- Suitable safety hardware and software measures should be implemented for the I/O interface so that a line or wire breakage on the signal side does not result in undefined states in the automation devices.

2.6.2 Device Destruction by Exceeding Allowed Supply Voltage

The EU5C-SWD-POWERLINK Gateway must only be operated with the specified supply voltage.

- Make sure that the limits of the allowed range for the supply voltage are not exceeded. A supply voltage above the upper limit can cause severe damage of the gateway!
- A supply voltage below the lower limit can cause malfunction of the gateway!
- Ensure a reliable electrical isolation of the low voltage for the 24 volt supply. Only use power supply units complying with IEC 60364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in the Technical Data EU5C-SWD-POWERLINK Gateway section on page 67.
2.6.3 Electrostatic Sensitive Device

The EU5C-SWD-POWERLINK Gateway is sensitive to electrostatic discharge, which can cause internal damage and affect its normal operation. Therefore adhere to the necessary safety precautions for components that are vulnerable to electrostatic discharge when you install or remove the gateway. Follow the guidelines listed hereafter when you handle the gateway:

- Touch a grounded object to discharge potential static before you handle the gateway.
- Wear an approved grounding wrist strap.
- If possible, use a static-safe workstation.
- When not in use, store the device in appropriate static-safe packaging.
2.7 Labeling of Safety Messages

In this document, the safety instructions and property damage messages are designed according both to the internationally used safety conventions as well as to the ANSI Z535 standard.

- The **Section Safety Messages** at the beginning of a chapter are pinpointed particularly. They are highlighted by a specific safety symbol and a signal word according to the degree of endangerment. In the safety message, the nature of the hazard is indicated.

- The **Integrated Safety Messages** embedded in operating instructions are highlighted by a signal word according to the degree of endangerment and possibly by a safety symbol. In the safety message, the nature of the hazard is indicated.

<table>
<thead>
<tr>
<th>Safety symbol</th>
<th>Sort of warning or principle</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Warning of personal injury or property damage</td>
</tr>
<tr>
<td></td>
<td>Warning of damages by electrostatic discharge</td>
</tr>
<tr>
<td></td>
<td>Principle: Disconnect the power plug</td>
</tr>
</tbody>
</table>

Table 7: Safety Symbols and Sort of Warning or Principle

<table>
<thead>
<tr>
<th>Signal word</th>
<th>Meaning</th>
<th>Meaning USA</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>Indicates a direct hazard with high risk, which will have as consequence death or grievous bodily harm if it is not avoided.</td>
<td>Indicates a hazardous situation which, if not avoided, will result in death or serious injury.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Indicates a possible hazard with medium risk, which will have as consequence death or (grievous) bodily harm if it is not avoided.</td>
<td>Indicates a hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Indicates a minor hazard with medium risk, which could have as consequence personal injury, if it is not avoided.</td>
<td>Indicates a hazardous situation which, if not avoided, may result in minor or moderate injury.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Indicates a property damage message.</td>
<td>Indicates a property damage message.</td>
</tr>
<tr>
<td>Note</td>
<td>Indicates an important note in the manual.</td>
<td>Indicates an important note in the manual.</td>
</tr>
</tbody>
</table>

Table 8: Signal Words
3 Descriptions and Requirements

3.1 Device Description EU5C-SWD-POWERLINK Gateway

3.1.1 Function

The EU5C-SWD-POWERLINK Gateway integrates a SmartWire-DT network into an Ethernet POWERLINK network. The Gateway creates a data connection between the participants (the slave devices) of the subordinate SmartWire-DT network and the Managing Node (the master device or PLC) of the superordinate POWERLINK network.

The gateway acts as master in the SmartWire-DT network on the one hand, and on the other hand as modular Controlled Node (slave device) in the POWERLINK network. It thereby presents each connected SmartWire-DT participant as individual module to the POWERLINK Managing Node.

The cyclic process data is exchanged transparently between both networks. 1000 Bytes of process input/output data can in sum be exchanged with up to 99 SmartWire-DT participants (slaves).

Figure 1: Data Flow EU5C-SWD-POWERLINK Gateway
3.1.2 Configuration

There are three types of configurations that are relevant for commissioning and operating the EU5C-SWD-POWERLINK gateway.

The actual configuration is the current actual constellation of the devices at the SmartWire-DT bus connected to the SmartWire-DT interface of the gateway. It is always scanned after each restart of the gateway. This procedure can not be influenced.

In case the actual configuration complies with the configuration envisaged for operation, the actual configuration can be captured as target configuration and stored zero-voltage safe in the device. This capturing and storing of the actual configuration as target configuration can be achieved either by pressing the configuration button located at the front panel of the gateway or by using the SWD-Assist software (for the position of the configuration button, see Device Picture section on page 27).

This target configuration is then available within the gateway even after power-off or restart of the device. If a target configuration has been stored, the gateway checks on each restart whether the actual configuration complies with the target configuration. In case the gateway detects inadmissible deviations, it will not go into operation. If the actual configuration deviates from the target configuration because of a device failure or removal on the SWD bus, the SWD LED on the gateway starts to blink red (for the position of the SWD LED, see Positions of the LEDs section on page 28).

If no errors are detected, the gateway is in principle ready for operation, but remains in waiting until the so-called planned configuration is downloaded to the gateway via the SWD-Assist software.

Without a target configuration, the gateway will not go into operation. The target configuration therefore has to be generated

- when you commission the gateway for the first time,
- after replacing a SmartWire-DT slave or
- after deliberately changing the setup of the SmartWire-DT network in any other way.

The third configuration is the planned configuration (in this document also called project configuration). It is created by using the SWD-Assist software and contains the desired configuration and the parameters of the SmartWire-DT network. It can be manually created in SWD-Assist by adding the individual device symbols in the "workbench" window, or it can be automatically created by taking over (i.e. reading-in) the target configuration from the gateway. The latter method is less prone to errors and therefore recommended.

The project configuration has to be complemented in SWD-Assist with the device-specific parameters of the SWD slaves and the POWERLINK-specific parameters (i.e. the node ID of the gateway). It then has to be downloaded from the configuration PC to the gateway via USB, where it is stored (like the target configuration) zero voltage-safe in the flash memory of the device.
The gateway checks the project configuration against the target configuration after each restart. SWD-Assist lets you define individual SWD slaves in the project configuration as being “non-mandatory” (which means that these slaves are allowed to be missing in the target configuration). Thus project configuration and target configuration must not necessarily comply with each other, but must be compatible. The result of this checking is indicated by the **Config LED** on the gateway (for the position of the Config LED, see *Positions of the LEDs* section on page 28).

In order to acquaint the gateway with the POWERLINK Managing Node within its POWERLINK configuration, you have to generate an XDD device description file out of the project configuration in SWD-Assist, and then and export it. This file contains the projected/planned configuration of the gateway in a standardized description format, which complies with general POWERLINK specifications. The XDD file then has to be imported into your POWERLINK engineering tool (e. g. Automation Studio by B & R). Afterwards, you can add the gateway in the engineering tool to an already existing POWERLINK project as Controlled Node and perform a data mapping for the contained I/O modules (i.e. the SmartWire-DT slaves). Finally, you can load the project onto your POWERLINK Managing Node.
3.1.3 Interfaces

The gateway features a SmartWire-DT interface (plug, 8-pole), a 2-port switch Ethernet interface (RJ45) and a Mini-USB interface. Via the Mini-USB interface, the gateway can be accessed, configured and diagnosed with the SWD-Assist software.

3.1.4 Diagnosis

The gateway can be diagnosed by connecting the SWD-Assist software to the Mini-USB interface. For further information, please refer to the SWD-Assist online help.

The POWERLINK protocol also provides diagnostic functions. For further information, see Diagnosis/Status Response section on page 61.

3.1.5 Firmware and Device Description File

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent firmware already loaded. Which firmware version is loaded in the gateway at the time of delivery can be inferred from the device type label (see Device Type Label section on page 32).

You can update the firmware from your configuration PC by using an ordinary web browser. A web server embedded in the gateway provides a special web page for updating the firmware. This web server can be accessed via the Ethernet interface of the Gateway. For more details on this, please refer to the Updating Firmware chapter on page 62 ff.

A device description file in XDD format can be generated by the SWD-Assist software. It can then be imported into a POWERLINK engineering tool (like e. g. Automation Studio by B & R).
3.2 Prerequisites for Operation

The following prerequisites must be fulfilled to operate the EU5C-SWD-POWERLINK Gateway:

3.2.1 Network Systems

- SmartWire-DT network with maximum number of up to 99 participants/stations/slaves and maximum extension of up to 600 meters.
- Ethernet POWERLINK network with POWERLINK PLC (Managing Node). Maximum cable length for one segment (i.e., cable between two devices or hubs) is 100 meters.

3.2.2 Power Supply

**NOTICE**

In safety-relevant applications the power supply providing power for the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).

**NOTICE**

Ensure a reliable electrical isolation of the low voltage for the 24 volt supply. Only use power supply units complying with IEC 60364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

**NOTICE**

You must take safety precautions (emergency switching off) in the external circuitry of the EU5C-SWD-POWERLINK and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.

**Important!**

Please take into consideration the total power consumption of your SmartWire-DT network and, if necessary, plan for an additional feeder module EU5C-SWD-PF2.

You can find information on the power consumption in the operating manuals of the SmartWire-DT devices.
3.2.2.1 POW Power Connection

A Power supply of 24 V DC for the coupling unit and for the Smart-Wire-DT slave electronics is needed at the connection POW.

On the SmartWire-DT gateway, connect the POW and AUX supply voltages via separate miniature circuit-breakers or fuses:

**Miniature circuit-breaker 24 V DC for POW**

- Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN 60898:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; trip types C or Fuse 3 A, utilization class gL/gG
- Cable protection for cable AWG 24 in accordance with UL 508 und CSA-22.2 No. 14:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; Tripping characteristics C or Fuse 3 A

3.2.2.2 AUX Power Connection

If any switching devices are also to be connected, for example via the DIL-SWD-32-001/002 SmartWire-DT slaves, a 24 V DC supply will also be required at the AUX power connection. This provides the supply for activating the contactor coils. This supply must be protected by an automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z characteristic).

If switching devices with an activation power greater than 3 A are connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-PF2 must be used.

On the SmartWire-DT gateway, connect the POW and AUX supply voltages via separate miniature circuit-breakers or fuses:

**Miniature circuit-breaker 24 V DC for AUX**

- Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN 60898:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; trip type Z or Fuse 3 A, utilization class gL/gG
- Cable protection for cable AWG 24 in accordance with UL 508 und CSA-22.2 No. 14:
  - Miniature circuit-breaker 24 V DC rated operational current 2 A; Tripping characteristics Z or Fuse 2 A
4 Device Picture, Connectors and LEDs

4.1 Device Picture

Figure 2: Front View EU5C-SWD-POWERLINK Gateway

1. 24 V power supply POW
2. Ethernet POWERLINK interface (RJ45)
3. LEDs communication status POWERLINK (see subsequent section for details)
4. Mini-USB interface
5. Configuration button
6. LEDs Gateway functions (see subsequent section for details)
7. 24 V power supply AUX
8. SmartWire-DT connection (plug, 8-pole)
4.2 Positions and Meaning of the LEDs

4.2.1 Positions of the LEDs

1. **POW**: System status
2. **APL**: Application status
3. **Config.**: Configuration status
4. **SWD**: SmartWire-DT status
5. **BS**: POWERLINK bus status
6. **BE**: POWERLINK bus error
7. **L/A**: LINK/Activity for channel 0
8. Receive/Transmit (RX/TX) for channel 0
9. **L/A**: LINK/Activity for channel 1
10. Receive/Transmit (RX/TX) for channel 1

*Figure 3: LEDs EU5C-SWD-POWERLINK Gateway*
### 4.2.2 Descriptions of the LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>POW</td>
<td>Duo-LED yellow/green</td>
<td></td>
<td><strong>Duo-LED yellow/green</strong></td>
</tr>
<tr>
<td></td>
<td>(yellow) On</td>
<td></td>
<td>Bootloader netX (= rom loader) is waiting for Second Stage Bootloader.</td>
</tr>
<tr>
<td></td>
<td>(green/yellow) Flashing</td>
<td>green/yellow</td>
<td>Second Stage Bootloader is waiting for firmware.</td>
</tr>
<tr>
<td></td>
<td>(green) On</td>
<td></td>
<td>Operating system running, firmware is started.</td>
</tr>
<tr>
<td></td>
<td>(off) Off</td>
<td></td>
<td>Power supply for device is missing or hardware is defect.</td>
</tr>
<tr>
<td>APL</td>
<td>Duo-LED red/green</td>
<td></td>
<td><strong>Duo-LED red/green</strong></td>
</tr>
<tr>
<td></td>
<td>(green) On</td>
<td></td>
<td>Communication on POWERLINK and SmartWire-DT is in cyclic data exchange and the gateway function is executed.</td>
</tr>
<tr>
<td></td>
<td>(green) Flashing 1 s off, 1 s on</td>
<td></td>
<td>Gateway is initialized, but the communication on POWERLINK and SmartWire-DT is not in cyclic data exchange.</td>
</tr>
<tr>
<td></td>
<td>(red) Flashing 1 s off, 1 s on</td>
<td></td>
<td>Gateway is initialized, but the SmartWire-DT configuration is missing or in error.</td>
</tr>
<tr>
<td></td>
<td>(red) On</td>
<td></td>
<td>Gateway has detected an error during the initialization: Missing configuration, error in configuration or internal error.</td>
</tr>
<tr>
<td>Config</td>
<td>Duo-LED red/green</td>
<td></td>
<td><strong>Duo-LED red/green</strong></td>
</tr>
<tr>
<td></td>
<td>(green) On</td>
<td></td>
<td>The project configuration complies with the target configuration. Data exchange between gateway and PLC via POWERLINK is possible.</td>
</tr>
<tr>
<td></td>
<td>(green) Flashing</td>
<td></td>
<td>The project configuration does not comply with the target configuration, but is compatible with it. Data exchange between gateway and PLC via POWERLINK is possible.</td>
</tr>
<tr>
<td></td>
<td>(red) On</td>
<td></td>
<td>The project configuration and the target configuration are not compatible. Data exchange between gateway and PLC via POWERLINK is not possible.</td>
</tr>
<tr>
<td></td>
<td>(off) Off</td>
<td></td>
<td>No communication with the POWERLINK PLC, or the gateway does not have a project configuration.</td>
</tr>
</tbody>
</table>

*Table 9: Description of the LEDs (1)*
<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SWD Status</strong></td>
<td><strong>SmartWire-DT Number in picture:</strong> 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Duo-LED red/green/orange</strong></td>
<td>(orange = red/green at same time)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(green)</td>
<td>On</td>
<td>The actual configuration complies with the target configuration. Data exchange between gateway and SmartWire-DT slaves takes place.</td>
<td></td>
</tr>
<tr>
<td>(red)</td>
<td>Flashing</td>
<td>The gateway misses its target configuration or a necessary SmartWire-DT slave is missing or the target configuration does not comply with the actual configuration. <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
<td></td>
</tr>
<tr>
<td>(green)</td>
<td>Flashing</td>
<td>Slave addressing is active (after power-on or download of a project configuration containing empty modules). <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
<td></td>
</tr>
<tr>
<td>(red)</td>
<td>On</td>
<td>Short-circuit on the 15 V power supply or no SmartWire-DT slave is connected. <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
<td></td>
</tr>
<tr>
<td>(orange)</td>
<td>Flashing</td>
<td>After having pressed the configuration button: The gateway reads the actual configuration and stores it as target configuration.</td>
<td></td>
</tr>
<tr>
<td><strong>BS POWERLINK Bus Status</strong></td>
<td><strong>Number in picture:</strong> 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Duo-LED red/green</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(off)</td>
<td>Off</td>
<td>Controlled Node (gateway) is initialized</td>
<td></td>
</tr>
<tr>
<td>(green)</td>
<td>Flickering</td>
<td>Controlled Node (gateway) is in basic Ethernet state</td>
<td></td>
</tr>
<tr>
<td>Single Flash</td>
<td>Controlled Node (gateway) is in state “Pre-Operational 1”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double Flash</td>
<td>Controlled Node (gateway) is in state “Pre-Operational 2”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triple Flash</td>
<td>Controlled Node (gateway) is in state “ReadyToOperate”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Controlled Node (gateway) is in state “Operational”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blinking</td>
<td>Controlled Node (gateway) is in state “Stopped”</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>BE POWERLINK Bus Error</strong></td>
<td><strong>Number in picture:</strong> 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Duo-LED red/green</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(off)</td>
<td>Off</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td>(red)</td>
<td>On</td>
<td>Controlled Node (gateway) has detected an error</td>
<td></td>
</tr>
<tr>
<td><strong>L/A (RJ45) Ch0 &amp; Ch1</strong></td>
<td><strong>Numbers in picture:</strong> 7 &amp; 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LED green</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(green)</td>
<td>On</td>
<td>Link: Gateway has connection to Ethernet</td>
<td></td>
</tr>
<tr>
<td>(green)</td>
<td>Flashing</td>
<td>Activity: Gateway sends/receives Ethernet frames</td>
<td></td>
</tr>
<tr>
<td>(off)</td>
<td>Off</td>
<td>Gateway has no connection to Ethernet</td>
<td></td>
</tr>
<tr>
<td><strong>(RJ45) Ch0 &amp; Ch1</strong></td>
<td><strong>Numbers in picture:</strong> 8 &amp; 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LED yellow</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(yellow)</td>
<td>-</td>
<td>This LED is not used</td>
<td></td>
</tr>
</tbody>
</table>

**Table 10: Description of the LEDs (2)**
4.3 Pinning POWERLINK Interface

The following picture shows the pinning of the Real-Time Ethernet interface of the Gateway:

![Ethernet Interface Pin Assignment](image)

**Figure 4: Pinning of the Ethernet Interface (RJ45)**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TX +</td>
<td>Transmit Data +</td>
</tr>
<tr>
<td>2</td>
<td>TX –</td>
<td>Transmit Data –</td>
</tr>
<tr>
<td>3</td>
<td>RX +</td>
<td>Receive Data +</td>
</tr>
<tr>
<td>4</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
<tr>
<td>5</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
<tr>
<td>6</td>
<td>RX –</td>
<td>Receive Data –</td>
</tr>
<tr>
<td>7</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
<tr>
<td>8</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
</tbody>
</table>

**Table 11: Ethernet Interface Channel 0 and Channel 1 Pin Assignment (RJ45)**

**Note:** The Ethernet interface supports Auto-Crossover.
4.4 Device Type Label

The EU5C-SWD-POWERLINK Gateway is equipped with a device type label, which provides the following information:

1. Version of firmware (at time of delivery)
2. Information on power supply for switching devices (AUX)
3. Information on power supply for Gateway and Smart-Wire-DT slaves (POW)
4. Information on wire gauge of power supplies
5. Operating ambient temperature
6. Device type name
7. Part number
8. Hardware revision number
9. Serial number

Figure 5: Device Type Label EU5C-SWD-POWERLINK Gateway
# Getting Started

The following table provides an overview of the steps necessary for installing and commissioning the EU5C-SWD-POWERLINK Gateway.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>For details see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Install gateway</strong></td>
<td>Chapter Installing Gateway on page 34</td>
</tr>
<tr>
<td>1.1</td>
<td>Take safety precautions</td>
<td>Section Safety Messages on page 34</td>
</tr>
<tr>
<td>1.2</td>
<td>Mount gateway onto top hat rail</td>
<td>Section Mounting Gateway onto Top Hat Rail on page 35</td>
</tr>
<tr>
<td>1.3</td>
<td>Connect gateway to power supply</td>
<td>Section Connecting Gateway to Power Supply on page 38</td>
</tr>
<tr>
<td>1.4</td>
<td>Connect gateway to SmartWire-DT network</td>
<td>Section Connecting SmartWire-DT on page 40</td>
</tr>
<tr>
<td>2</td>
<td><strong>Configure gateway</strong></td>
<td>Chapter Configuring Gateway on page 42</td>
</tr>
<tr>
<td>2.1</td>
<td>Configure SmartWire-DT network in gateway</td>
<td>Section Configuring SmartWire-DT network in Gateway on page 42</td>
</tr>
<tr>
<td>2.2</td>
<td>Install SWD-Assist and USB driver on configuration PC</td>
<td>Section Installing SWD-Assist and USB Driver on Configuration PC on page 44</td>
</tr>
<tr>
<td>2.3</td>
<td>Connect configuration PC to gateway via USB</td>
<td>Section Connecting Gateway to Configuration PC via USB on page 46</td>
</tr>
<tr>
<td>2.4</td>
<td>Configure gateway project in SWD-Assist</td>
<td>Section Configuring Gateway in SWD-Assist (Creating Project Configuration) on page 47</td>
</tr>
<tr>
<td>2.5</td>
<td>Download project configuration to gateway</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td><strong>Configure gateway in POWERLINK</strong></td>
<td>Chapter Configuring Gateway in POWERLINK on page 53</td>
</tr>
<tr>
<td>3.1</td>
<td>Create XDD device description file for gateway in SWD-Assist</td>
<td>Chapter Configuring Gateway in POWERLINK on page 53</td>
</tr>
<tr>
<td>3.2</td>
<td>Import XDD device description file in POWERLINK engineering tool</td>
<td></td>
</tr>
<tr>
<td>3.3</td>
<td>Configure gateway in POWERLINK engineering tool</td>
<td></td>
</tr>
<tr>
<td>3.4</td>
<td>Download POWERLINK configuration to PLC</td>
<td></td>
</tr>
<tr>
<td>3.5</td>
<td>Connect gateway to POWERLINK network</td>
<td>Section Connecting POWERLINK on page 41</td>
</tr>
</tbody>
</table>

*Table 12: Getting Started*
6 Installing Gateway

6.1 Safety Messages

⚠️ WARNING
Please observe the following safety messages when you install and handle the gateway!

- First disconnect the power plug of the device.
- Make sure that the power supply is off at the device.
- Cover or enclose neighboring units that are live.

⚠️ NOTICE
Electrostatic Sensitive Device

The gateway is sensitive to electrostatic discharge, which can cause internal damage and affect its normal operation. Therefore adhere to the necessary safety precautions for components that are vulnerable to electrostatic discharge, when you install or handle the gateway.

- Do not touch the metal pins of the connectors of the gateway.
- Touch a grounded object to discharge potential static.
- Wear an approved grounding wrist strap.
- If available, use a static-safe workstation.
- When not in use, store the device in an appropriate static-safe packaging.
6.2 Mounting Gateway

No tools are required for mounting the EU5C-SWD-POWERLINK Gateway onto a top hat rail. The back of the gateway (1) carries a spring-fitted bolt (2), by which the gateway can be clamped to the rail (3).

![Figure 6: Mounting Principle of the Gateway](image)

6.2.1 Mounting Gateway onto Top Hat Rail

To mount the gateway onto the top hat rail, proceed as follows:

- Make sure that the gateway is disconnected from any power supply.
- Cover or enclose neighboring units that are live.

- Tilt the gateway slightly and hook it into the upper railing from above, thereby pushing down the gateway with slight force, in order to overcome the resistance of the spring in the bolt.

![Figure 7: Hook Gateway to Upper Railing](image)
Keep on pushing the gateway downwards and tilt it back into vertical position, thereby hooking the gateway into the lower railing.

Let go of the gateway. The spring inside the bolt automatically pushes the gateway upwards into the railings, thereby fixing the gateway to the top hat rail.
6.2.2 Removing Gateway from Top Hat Rail

To remove the gateway from the top hat rail, proceed as follows:

- First disconnect the power plugs from the gateway.
- Make sure that the power supply is off at the gateway.
- Cover or enclose neighboring units that are live.

- Push down the gateway with slight force (to overcome the resistance of the spring in the bolt), then unhook the gateway first from the lower railing and then from the upper railing.

Figure 10: Unhook Gateway
6.3 Connecting Gateway to Power Supply

WARNING

Danger of lethal injuries by unexpected starting up of motors or machinery!

If you have already integrated devices into a system, secure the operating range of any connected parts of the system against access, so that nobody is endangered by motors or machinery starting up unexpectedly.

NOTICE

In safety-relevant applications, the power supply providing power to the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).

NOTICE

You must take safety precautions (emergency switching off) in the external circuitry of the EU5C-SWD-POWERLINK Gateway and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.

Important!

Please take into consideration the total power consumption of your SmartWire-DT network and, if necessary, plan for an additional feeder module EU5C-SWD-PF2.

You can find information on the power consumption in the operating manuals of the SmartWire-DT devices.

- Connect the 24 V DC voltage to the POW terminals on the front side of the gateway. The POW connection provides the voltage for the gateway itself and for the SmartWire-DT slave electronics.

Note: For the 15 V supply of the SmartWire-DT slaves, the gateway contains an additional power feed module with an amperage of 0.7 A.
If necessary, connect the 24 V DC voltage for the contactor coils to the **AUX** terminals on the front side of the gateway.

![Gateway Power Supply](image)

**Figure 11: Gateway Power Supply**

**Note:** The **AUX** supply is required if any switching devices are also to be connected, for example, via the DIL-SWD-32-001/002 SmartWire-DT slaves. The **AUX** connection provides the supply for activating the contactor coils. This supply must be protected by an automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z characteristic).

If switching devices with an activation power greater than 3 A are connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-PF2 must be used.

---

**Potential conditions between the components**

The entire SmartWire-DT system operates on a common supply voltage. Provide a common star point for the earth wiring. In this way, the various slaves in the SmartWire-DT system will not be electrically isolated from one another.

The POWERLINK network and the SmartWire-DT system are electrically isolated from one another.
6.4 Connecting SmartWire-DT

- Connect the SmartWire-DT network to the gateway. To do so, use the SmartWire-DT cable SWD4-100LF8-24 and the SWD4-8MF2 relevant blade terminal or prefabricated cables of type SWD4-(3/5/10)F8-24-2S.

![Connecting SmartWire-DT to Gateway](image)

**NOTICE**

Switch off the power supply, if you are reconnecting slaves in the SmartWire-DT system or reconnecting the ribbon cable connection. Otherwise the SmartWire-DT slaves can be destroyed!

**Note:** Detailed instructions on adapting the SmartWire-DT external device plug (SWD4-8SF2-5) to the 8 pole Smart-Wire-DT cable are provided in chapter *Fitting external device plugs SWD4-8SF2-5* of the manual SmartWire-DT – The System, MN05006002Z-EN (previously AWB2723-1617en).
6.5 Connecting POWERLINK

- Connect the RJ45 plug of the POWERLINK cable to one of the Ethernet connectors on the gateway.

![Figure 13: Connecting POWERLINK to Gateway](image)

**Important!**

Please observe the following notes on POWERLINK cabling:

- Use only hubs, no switches.
- Maximum cable length in a segment (allowed space between individual devices/hub) is 100 meters.

6.6 EMC-Conformant Wiring of the Network

Undesired faults can occur on the bus due to electromagnetic interference. This can be minimized beforehand by the implementation of suitable EMC measures. These include:

- EMC-conformant system configuration,
- EMC compliant cable routing,
- Measures that do not allow the occurrence of large differences in potential and
- correct installation of the POWERLINK system (cables, connection of the bus connectors, etc.)

The effects of electromagnetic interference can be significantly reduced by fitting a shield.

For more detailed information on this, please refer to the *IAONA Industrial Ethernet -Planning and Installation Guide* by IAONA e.V. Magdeburg, Germany.
7Configuring Gateway

For data exchange between the gateway and the POWERLINK Managing Node, the gateway needs valid target and project configurations of the SmartWire-DT network. This chapter describes how to create and store these configurations in the gateway.

7.1 Configuring SmartWire-DT network in Gateway (Creating Target Configuration)

When you commission the gateway, you have to read-in the actual configuration of the SmartWire-DT network (i.e. the line-up of the participants/devices connected to the SWD bus) and store it as target configuration.

Reading and storing the SmartWire-DT network configuration takes place by pressing the configuration button on the gateway (for the position of the configuration button, see figure Front View EU5C-SWD-POWERLINK Gateway on page 27). All SmartWire-DT slaves are re-addressed in ascending or descending order by this process. As an alternative, you can generate and store the target configuration by using the SWD-Assist software (the gateway must be connected to SWD-Assist via USB).

This process should only take place in the case of:

- initial commissioning,
- replacement of a defective slave or
- deliberate change to the configuration.

Important!

If there is a faulty configuration and the configuration button is pressed, only the slaves up to the failed device are addressed and stored. Use of the remaining slaves is not possible until the defective slave has been replaced and the configuration has been read-in again by pressing the configuration button.

The remanently stored target configuration is compared with the current configuration (actual configuration) each time the gateway is restarted and during bus operation. If the gateway recognizes that a required SmartWire-DT slave cannot be reached or a wrong slave type is determined, the gateway will not go into operation or stops operating. This depends in each case on the setup of the network which has been defined in the planned/project configuration. In case of error, the SmartWire-DT status LED (SWD LED) starts to blink in red (for the position of the SWD LED, see Positions of the LEDs section on page 28).

If a SmartWire-DT slave has failed, the SmartWire-DT network can still be operated with the remaining slaves, depending on the settings in the planned/project configuration (even after a repeated power up of the gateway). The failure is reported to the application.
Prerequisites for reading-in the SmartWire-DT configuration are:

- All SmartWire-DT slaves are connected to the SmartWire-DT line.
- The SmartWire-DT network is connected to the gateway.
- The voltage POW is applied to the gateway and the power LED POW is on.
- The voltage AUX is applied (if necessary).
- The SmartWire-DT status LEDs of the individual SmartWire-DT slaves are on or are flashing.
- The POWERLINK network is disconnected from the gateway by removing the RJ45 plug from the Ethernet interface of the gateway.

To read-in the SmartWire-DT configuration proceed as follows:

- Make sure that POWERLINK is disconnected from the gateway.
- Press the configuration button on the gateway for at least two seconds (for the position of the configuration button, see figure *Front View EU5C-SWD-POWERLINK Gateway* on page 27).

**Note:** Take care to push-in the button properly. You have to feel and overcome a slight resistance at the end when pushing the button into the gateway, otherwise the button won’t trigger.

- The SmartWire-DT status LED (SWD LED) on the gateway begins to flash orange. The SmartWire-DT status LEDs on the SmartWire-DT slaves also flash. All slaves are addressed in sequence, the complete configuration is stored retentively as gateway target configuration.
- The SmartWire-DT status LED (SWD LED) on the gateway shows steady green.
7.2 Installing SWD-Assist and USB Driver on Configuration PC

You need the **SWD-Assist** software on your configuration PC in order to create, parameterize and download a project configuration to the gateway. With SWD-Assist, you can also perform a diagnosis of the SmartWire-DT network and create an XDD device description file, which can imported into your POWERLINK engineering tool for the purpose of configuring the POWERLINK Managing Node.

In the installation wizard of the SmartWire-DT Gateway Solutions DVD, you can install the version of the SWD-Assist software delivered on the DVD, or you can choose to be directed to an internet website from which you can download the latest version of SWD-Assist (if available).

In order to establish an USB connection between SWD-Assist and the gateway, you also need to install the **USB driver** on your configuration PC. An installation program for the USB driver is delivered on the SmartWire-DT Gateway Solutions DVD. It contains all components needed for the installation of the driver under Windows XP, Windows Vista, Windows 7 and Windows 8. It detects whether the 32 bit or the 64 bit version of the driver needs to be installed.

It is recommended to use the installation program to install the USB driver. It is also recommended to install the USB driver before you connect the gateway to your configuration PC via USB for the first time ("software first" principle).

**Step-by-step Instructions**

To install the software on your configuration PC, proceed as follows:

- Insert the SmartWire-DT Gateway Solutions DVD into your local DVD-ROM drive.

  - If the “Auto Play” function of your Windows PC is enabled, the start screen of the DVD is displayed.

**Note:** As an alternative, you can also open the start screen of the DVD by double-clicking the `SmartWire.exe` file in the root directory of the DVD.

- In the menu of the start screen, click **Install Planning and Configuration Tools**.
The **SmartWire-DT Installation Wizard** opens:

![SmartWire-DT Installation Wizard](image)

**Figure 14: SmartWire-DT Installation Wizard**

**Note:** The wizard automatically checks for already installed software components (which e.g. might have been installed for an earlier project), and lists the missing components accordingly.

- Select the appropriate installation options.
- Read the license agreement, then select **License agreement read and accepted**.
- Click **Execute**, then follow the instructions of the installation program.

**Note:** Under Windows XP, the installation process of the USB driver is not yet finished after having executed the driver setup. The installation process has to be completed in the **Found New Hardware Wizard**, which automatically opens when you connect the gateway to your configuration PC via USB cable for the first time (see following section).
7.3 Connecting Gateway to Configuration PC via USB

- Make sure that the gateway is connected to a voltage supply.
- Connect the Mini USB interface of the gateway with a USB interface of your configuration PC (for the position of the USB interface on the gateway, see section Device Picture on page 27).

Windows XP:

When you connect the gateway via USB for the first time to a PC running under Windows XP, the Found New Hardware Wizard opens:

- Answer the question Can Windows connect to Windows Update…?, with No, not this time. Then click Next button.
- If you have already carried out the setup of the USB driver (as recommended), you can ignore the wizard’s request to insert a CD or floppy disk. Answer the What do you want the wizard to do? question by selecting the Install the software automatically option, then click Next button.

Windows copies the driver files to the Windows directories.

- After the installation is complete, click Finish button.

Windows 7 and 8:

If you have carried out the setup of the USB driver before first connecting the USB cable (as recommended), the installation will automatically be finished. Afterwards, the USB connection is instantly operative.
7.4 Configuring Gateway in SWD-Assist (Creating Project Configuration)

This section describes how to create and parameterize the project configuration (also called planned configuration) in SWD-Assist. This project configuration afterwards has to be downloaded to the gateway, in order to make it operative.

You can create the project configuration in SWD-Assist by manually adding the individual SWD participants symbols from the device catalog to the SWD string in the “workbench” window, or it can be automatically created by taking over (i.e. reading-in) the target configuration from the gateway (for a description of how to create the target configuration, see Configuring SmartWire-DT network in Gateway (Creating Target Configuration) on page 42). This section describes the easier and faster method of automatically taking over the target configuration from the gateway.

1. Start SWD-Assist.
   - In the Windows Start menu, choose All Programs > Eaton > SWD-Assist.
   - The SWD-Assist software opens.
   - If the SWD-Assist catalogue selection dialog window appears, choose Eaton EMEA option and click OK button.
   - SWD-Assist opens in the Project View:

![Figure 15: Start Window of SWD-Assist](image-url)
2. Create online connection to gateway.

- To change from the **Project View** to the **Communication View**, choose **View > Communication View** from the menu bar, or click the icon in the icon bar.

- The **Communication View** opens:

![Communication View in SWD-Assist](image)

*Figure 16: Communication View in SWD-Assist*

- In the **Interface** drop-down list below **Connection setup**, select the COM port of your configuration PC to which you have connected the gateway via USB. You can recognize the correct port by the entry next to the COM port number (**Eaton EU5C-SWD**).

- Click **Online** button.
SWD-Assist establishes the online connection and reads-in the target configuration which had been stored in the gateway. The SWD devices belonging to the target configuration are depicted as blue symbols connected to the SWD bus:

![Figure 17: Target Configuration in SWD-Assist](image)

**Note:** If no target configuration has been stored in the gateway yet, you can create it now by clicking the **Renew** button in the **Target configuration** area in the left window. Thereby, the actual configuration (i.e. the current line-up of the devices connected to the SmartWire-DT network) is read-in, stored as target configuration in the gateway and transferred to SWD-Assist.

3. Generate project configuration from target configuration.
   - In the **Target configuration** area, click **Device => PC** button to save the target configuration from the device in SWD-Assist, in order to adapt it as project configuration (i.e. planned configuration).
   - Answer the security question with **Yes**.
   - In the **Connection setup** area, click **Offline** button.

4. Edit project configuration.
   - To change from **Communication View** back to **Project View** click button or press Ctrl+Alt+1 on your keyboard.
In the Project View, the former target configuration is now displayed as project configuration (i.e. planned configuration):

Figure 18: Planned Configuration in SWD-Assist: Set Device Parameters

- In the **Workbench** window, select an SWD slave device, then open the **Device Parameters** tab in the **Properties field** window (located below the **Workbench** window) and determine whether the device should be a **Required module** and whether it can be replaced with a **universal module**.
5. Set POWERLINK parameters in project configuration.

- In the **Workbench** window, select the EU5C-SWD-POWERLINK gateway.

![Figure 19: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of Gateway](image)

- Then open the **Powerlink parameters** tab in the **Properties field** window (located below the **Workbench** window) and enter the **Node-ID**, by which the gateway should be reached in the POWERLINK network.

6. Transfer project configuration to gateway.

- To change from the **Project View** to the **Communication View**, choose **View > Communication View** from the menu bar, or click **button in the icon bar.

- The Communication View opens.

- In the **Connection setup** area of the Communication View, click **Online** button.

- SWD-Assist re-establishes an online connection, reads-in the target configuration from the gateway again and displays it in the **Workbench** window.

**Note:** Before downloading the project configuration, you can let SWD-Assist compare it with the target configuration stored in the gateway by clicking the **PC = Device?** button in the **Target configuration** area.
In the Planned configuration area, click PC => Device button to transfer the project/planned configuration via USB to the gateway.

**Note:** The project configuration is stored in the gateway along with the target configuration. Any old project configuration file that might have existed in the gateway up to this point will be overwritten. If an old project configuration file exists in the gateway, you can let SWD-Assist compare it with the new project configuration by clicking the PC = Device? button in the Planned configuration area before downloading the new one.

The project configuration is copied to the gateway and stored there non-volatile. If the project configuration complies with the target configuration, the Config LED starts to show steady green light after a few seconds (see also Positions and Meaning of the LEDs section on page 28).
8 Configuring Gateway in POWERLINK

In order to acquaint the gateway with the POWERLINK Managing Node within its POWERLINK configuration, you need an XDD device description file. This file contains the projected/planned configuration of the gateway in a standardized description format, which complies with general POWERLINK specifications.

You can generate the XDD file in SWD-Assist from your project configuration and import it into your POWERLINK engineering tool, e.g. Automation Studio. There you can add the gateway as Controlled Node to an already existing POWERLINK project and perform a data mapping for the projected I/O modules (i.e. the SmartWire-DT devices). Afterwards you can load the POWERLINK project onto your POWERLINK Managing Node.

1. Generate XDD device description file in SWD-Assist.

   Open the project in SWD-Assist. (If you have just recently copied the project configuration to the gateway – see preceding section – change from the Communication View back to the Project View.)

   The Project View shows the project configuration:

   ![Figure 20: Planned Configuration in SWD-Assist](image)

   In the menu, select Project > Generate XDD file…

   The Save XDD file dialog window opens.

   Choose the directory where you want to store the XDD file and enter a file name, then click Save.
2. Import XDD device description file into Automation Studio.
   - Open your POWERLINK project in Automation Studio.
   - In the menu of Automation Studio, choose **Tools > Import Fieldbus Device**...
     - A file selection dialog window opens.
     - Select the XDD device description file, then click **Open**.
     - The XDD device description file is imported.

3. Add gateway to the POWERLINK project.
   - In the right window, select the Managing Node of your POWERLINK project.

![POWERLINK Project in Automation Studio](image)

*Figure 21: POWERLINK Project in Automation Studio*

- Open the context menu and choose **Insert...**
The Select controller module dialog window opens:

Figure 22: Select Controller Module Dialog in Automation Studio

- Make sure that the Insert module option is selected.
- Scroll the list for the Gateway XDD entry and select it. After selecting the entry, click Next.

The Module Parameter dialog window opens:

Figure 23: Module Parameter Dialog in Automation Studio

- In the Enter node number field, enter the Node-ID which you have assigned to the gateway in the project configuration of SWD-Assist.
- Click Next.
The **Module Parameter** dialog window closes and the gateway is displayed in the POWERLINK project:

In the left window, select the gateway.
Open context menu and select **Open I/O Mapping**.
In the right window, a list featuring the in- and outputs of the SmartWire-DT slaves opens:

![Diagram of I/O Mapping of SWD Slaves]

**Figure 26: I/O Mapping of SWD Slaves**

- Link the I/O data to variables.
- Save the project.

5. Load POWERLINK project to PLC via Ethernet.
- In the menu, choose **Project > Transfer To Target** to compile the project and load it onto the POWERLINK PLC.
- The project is compiled and loaded to the PLC.
9  POWERLINK Data Communication

9.1  Acyclical Communication

The POWERLINK Managing Node can exchange acyclic data with individual SmartWire-DT slaves via the gateway and the **Object Index 0x3000**. For **SDO Write** (acyclic output), i.e. for writing data to a SWD slave (e.g. a read request), the **Sub-Index 1** is provided. For **SDO Read** (acyclic input), i.e. for reading requested data from a SWD slave, the **Sub-Index 2** is provided.

9.1.1  SDO Write (Acyclic Output)

9.1.1.1  Read Request

**Elements SDO Write – Read Request**

For writing a *read request*, use **Object Index 0x3000** together with **Sub-Index 1** and the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave that you want to read (i.e. the address defined in the project configuration)</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>SWD-specific index of the SWD slave. Determines what kind of data you want to read, e.g. error counter or firmware version.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
<tr>
<td>Request Type</td>
<td>Type of request: <strong>Read</strong> or <strong>Write Request</strong>. A read request must have the value 0</td>
<td>uint8</td>
<td></td>
<td>0</td>
<td>0x00</td>
</tr>
<tr>
<td>Length</td>
<td>Maximum length of the expected response (in bytes)</td>
<td>uint8</td>
<td>1…120</td>
<td>120</td>
<td>0x78</td>
</tr>
</tbody>
</table>

*Table 13: Elements Read Request SDO Write*

**Example of SDO Write – Read Request**

In case the POWERLINK Managing Node wants to read the error counter (SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), and the expected response should not be longer than 120 Bytes, the **SDO Write** sent to the gateway must feature the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Object Index</th>
<th>Sub-Index</th>
<th>Elements</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0x3000</td>
<td>0x01</td>
<td>0x05 0x7F 0x00 0x78</td>
<td></td>
</tr>
</tbody>
</table>

*Table 14: Example Read Request SDO Write*
9.1.1.2 Write Request

Elements SDO Write – Write Request

For writing a write request to the SmartWire-DT slave, use Object Index 0x3000 together with Sub-Index 1 and the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave (i.e., the address defined in the project configuration)</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>SWD-specific index of the SWD slave. Determines where you want write data.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
<tr>
<td>Request Type</td>
<td>Type of request: Read or Write Request. A write request must have the value 1</td>
<td>uint8</td>
<td>Read Request = 0 [Write Request = 1]</td>
<td>1</td>
<td>0x01</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the data to be written (in bytes)</td>
<td>uint8</td>
<td>1…120</td>
<td>1</td>
<td>0x01</td>
</tr>
<tr>
<td>Data</td>
<td>Data to be written</td>
<td>uint8</td>
<td>(...)</td>
<td>0</td>
<td>0x00</td>
</tr>
</tbody>
</table>

Table 15: Elements Write Request SDO Write

Example of SDO Write – Write Request

In case the POWERLINK Managing Node wants to reset the error counter (SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), the SDO Write sent to the gateway must feature the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Object Index</th>
<th>Sub-Index</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0x3000</td>
<td>0x01</td>
<td>Slave Address</td>
</tr>
</tbody>
</table>

Table 16: Example Write Request SDO Write
9.1.2 SDO Read (Acyclic Input)

Elements SDO Read

The requested data can be read by using **Object Index 0x3000** together with **Sub-Index 2**. The response features the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave of which data has been read.</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>SWD index of the data which has been read, e.g. error counter or firmware version.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
<tr>
<td>Request Type</td>
<td>Type of request. A read request has the value 0</td>
<td>uint8</td>
<td>Read Request = 0 Write Request = 1</td>
<td>0</td>
<td>0x00</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the received response in bytes</td>
<td>uint8</td>
<td>1…120</td>
<td>120</td>
<td>0x78</td>
</tr>
<tr>
<td>Data</td>
<td>Actual data which has been read according to SWD Index, e.g. error counter or firmware version.</td>
<td>uint8 [120]</td>
<td>(...)</td>
<td>(...)</td>
<td>(...)</td>
</tr>
<tr>
<td>State</td>
<td>State of the response</td>
<td>uint8</td>
<td>Idle = 0 In progress = 1 Finished = 2 Error = 3</td>
<td>2</td>
<td>0x02</td>
</tr>
<tr>
<td>Error Code</td>
<td>Error detected by the SWD master (i.e. by the gateway)</td>
<td>uint32</td>
<td>No error = 0 JOBID_BUFFER_FULL = 0xC0AD0002 JOB_DENIED = 0xC0AD0003 NOT_AVAILABLE = 0xC0AD0004</td>
<td>0</td>
<td>0x00</td>
</tr>
</tbody>
</table>

Table 17: Elements SDO Read

Example SDO Read

In case the response is finished and no error was detected, the SDO Read (which is sent back by the gateway to the Managing Node in order to answer the SDO Write) features the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Index</td>
<td>Sub-Index</td>
<td>Slave Address</td>
<td>SWD Index</td>
<td>Request Type</td>
<td>Length</td>
<td>Data</td>
<td>State</td>
</tr>
<tr>
<td>0x3000</td>
<td>0x02</td>
<td>0x05</td>
<td>0x7F</td>
<td>0x00</td>
<td>0x78</td>
<td>(...)</td>
<td>0x02</td>
</tr>
</tbody>
</table>

Table 18: Example SDO Read
9.2 Diagnosis/Status Response

Diagnostic messages of the SWD slaves and the state of the gateway are reported via Error Entry Object 0x1003 or status response telegram. The number of the current diagnoses can be read from the object 0x1003/0. The individual diagnoses are presented in detail from 0x1003/1 onwards.

Structure Error Entry

<table>
<thead>
<tr>
<th>Structure Error Entry</th>
<th>Error Code: (2 bytes/UNSIGNED16)</th>
<th>Time Stamp of Event (8 bytes/UNSIGNED64)</th>
<th>Additional information: (8 bytes/UNSIGNED64)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry Type</td>
<td>0x7000</td>
<td></td>
<td>Byte 0: SWD diagnostic code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Byte 1 – 4: Error flags</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Unused bytes have value 0</td>
</tr>
</tbody>
</table>

Table 19: Structure of Error Entry

If Error Code 0xFF01 to 0xFF63 is displayed, byte 0 of the Additional Information field features a diagnostic code.

The ID of the slave reporting the error is located in the LSB (least significant byte) of the error code. The subsequent table lists some examples of extended diagnostic messages.

<table>
<thead>
<tr>
<th>Diagnostic code</th>
<th>Meaning</th>
<th>Used by</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>No diagnostic message active</td>
<td>All devices that support the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>extended diagnosis</td>
</tr>
<tr>
<td>0x10</td>
<td>Contact in middle position</td>
<td>RMQ</td>
</tr>
<tr>
<td>0x11</td>
<td>Contact short-circuit</td>
<td>RMQ</td>
</tr>
<tr>
<td>0x13</td>
<td>Output overload</td>
<td>I/O module</td>
</tr>
</tbody>
</table>

Table 20: Diagnostic Messages

More detailed information on this can be found in the manual SmartWire-DT Units, 05/11 MN05006001Z-EN by Eaton.

If Error Code 0xFF00 is displayed, a 32-bit variable with error flags is stored in the Additional Information field (byte 1 to 4).

Byte 0 of the Additional Information is 0x00.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit</th>
<th>dwBit</th>
<th>Relevance</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>16</td>
<td>Error</td>
<td>SWD: Necessary SmartWire-DT slave is missing</td>
</tr>
<tr>
<td>1</td>
<td>17</td>
<td></td>
<td>Warning</td>
<td>SWD: Optional SmartWire-DT slave is missing</td>
</tr>
<tr>
<td>4</td>
<td>28</td>
<td></td>
<td>Info</td>
<td>SWD: The use of compatible slaves is allowed</td>
</tr>
<tr>
<td>5</td>
<td>29</td>
<td></td>
<td></td>
<td>SWD: All slaves are registered as &quot;optional&quot;</td>
</tr>
</tbody>
</table>

Table 21: Error Flags if Error Code = 0xFF00
10 Updating Firmware

10.1 Overview

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent firmware already loaded. The version of the loaded firmware is stated on the device type label.

The integrated web server of the gateway provides a function to update the firmware of the gateway by HTTP via its Ethernet interface. All you need is a PC with an ordinary web browser connected to the gateway via Ethernet.

When you perform a firmware update, the old firmware file in the gateway will automatically be overwritten. The project configuration and the target configuration in the gateway remain untouched by the firmware update.

10.2 IP Address of Gateway

In order to connect to the WebServer, you need to know the IP address of the gateway. On shipment, the default IP address of the gateway is 0.0.0.0. On commissioning, the gateway receives its IP address with the project configuration which you have created and downloaded to the gateway by using the SWD-Assist software. POWERLINK uses the IP address 192.168.100.x, appended by the individual Node ID (x) of the device. Thus, if you have defined Node ID 10 in the project configuration of the gateway, the gateway will have the IP address 192.168.100.10 after downloading the project configuration to the device.

Using the Ethernet Device Configuration Tool

Apart from POWERLINK, you can assign a temporary IP-address to the gateway by using the Eaton Ethernet Device Configuration Tool and the netIdent protocol. This temporary IP address is stored volatile in the gateway and is thus lost after power-off at the device.

You can install this tool on your configuration PC by choosing the Install Planning and Configuration Tools option in the menu of the start screen of the product DVD, and then selecting the Ethernet Device Scanner/Configuration Tool option in the opening SmartWire-DT Installation Wizard (as an alternative, you can also double-click the EnDevConfigTool.msi file in the Software\EnDeviceCfg folder).
For information about how to use this tool, please refer to the operating instruction manual *Ethernet Device Configuration*, which is stored on the product DVD in the `Documentation\english\1.Software\Ethernet Device Setup Utility` directory.

---

**Note:** Before you can use the *Ethernet Device Configuration Tool* to assign a temporary IP address, you first have to perform a special reset operation on the gateway, in order to deactivate the POWERLINK connection. For this special reset, you must briefly disconnect the gateway from the voltage supply and keep the **configuration button** pushed in for two to three seconds while reconnecting the voltage supply. The **BS** and **BE** LEDs will automatically turn off after successful reset (for the positions of the configuration button and the LEDs on the gateway, see section *Device Picture* on page 27).

After having set the temporary IP address and having updated the firmware in the gateway via web browser and WebServer, you must perform an ordinary reset of the gateway.
10.3 Prerequisites

- The gateway is connected to a power supply.
- The gateway is connected to an IP network via its Ethernet interface.
- PC with web browser connected to the IP network.
- The IP address of the gateway is compatible to the Ethernet subnet of the PC.
- You know the IP address of the gateway.

**Note:** The current version of the firmware does not provide options to customize the user authentication of the web server by creating own groups, users or passwords.

10.4 Step-by-Step Instructions for Updating Firmware

1. Open web page for firmware update.
   - Start the web browser on your configuration PC.
   - In the address bar of your browser, enter the URL of the gateway: http://<IP address>
     - The home page of the WebServer opens.
   - In the navigation header of the web page, click **Firmware Update**.

**Note:** You can also open the firmware update page by entering the IP address http://<IP address>/fwupdate in the address bar of your browser.

- The following web page opens:

![Figure 27: Firmware Update via HTTP (as depicted in Internet Explorer)](image-url)
The **Firmware Identification** section displays the following parameters of the firmware currently loaded in the gateway:

- **Channel**: Location (port) of firmware
- **Name**: Name of loaded firmware
- **Version**: Version of loaded firmware
- **Date**: Date of creation of loaded firmware

The **Firmware Update** section features the following control elements:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse…</td>
<td>Opens the file selection dialog</td>
</tr>
<tr>
<td>Transfer</td>
<td>Uploads selected firmware file to the device</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels firmware update</td>
</tr>
</tbody>
</table>

*Table 22: Controls in Firmware Update Page*

2. Select new firmware file.
   - Click **Browse…** button, to open a dialog window for selecting the firmware file.
   - Navigate to the directory in which the firmware file is stored, select the file, and then click **Open**.

**Note**: The name of the firmware file for the gateway is E030K0U0.nxf.

- Path and name of the selected file are displayed in the field next to the **Browse…** button.

3. Download firmware file to gateway.

**NOTICE**

**Hazard of device damage by power failure during file transfer!**

Do not interrupt the power supply during transfer of the firmware file. A power failure while switching from the old to the already stored new firmware can cause severe malfunction of the device.

- Click **Transfer** button to download the new firmware file to the gateway.
- After you have started the upload by clicking the **Transfer** button, the validity of the firmware file is being checked by the system. If the file fails the validity check, the file will not be stored in the gateway and an error message will be displayed. If the file passes, the old firmware file in the gateway is overwritten by the new firmware. Afterwards, the WebServer requests a reset, in order to start the new firmware.
10.5 Resetting Gateway

After firmware download, you must reset the gateway in order to start the new firmware. If you have assigned a temporary IP address to the gateway with the Ethernet Device Configuration Tool, please note that the gateway loses this address after reset. The gateway then can be reached again under the IP address defined in the project configuration. If no project configuration is present in the device, the gateway falls back to its default IP address 0.0.0.0.

To reset the device, proceed as follows:

1. Open web page for reset.
   - In the navigation header of the web page, click **Reset**.

   **Note**: You can also open the reset page by entering the IP address `http://<IP address>/reset` in the address bar of your browser.

   The following web page opens:

   **Device Reset**

   Initiating a device reset will cause the device to reboot. A reboot will let the device **stopping all communications** immediately. Established connections will drop.

   Before you initiate a reset make sure that your system is in idle state and operated under maintenance condition in order to prevent system damages.

   Device parameters that have not been saved non-volatile such as a temporary IP address are getting lost during the reset.

   ☑ Please confirm you want to reset the device.

   ![Submit](submit.png) ![Cancel](cancel.png)

   *Figure 28: Reset via HTTP (as depicted in Internet Explorer)*

   **Important!**

   Please note the following consequences of a reset:

   - The firmware is being restarted and connections will be interrupted or timed out.
   - I/O bus communication is being stopped.
   - A temporary IP address assigned by the Ethernet Device Configuration Tool will be lost.

2. Perform reset.
   - Activate the checkbox in front of **Please confirm...** to acknowledge that you want to reset the device.

   **Note**: You can use the **Cancel** button to uncheck the checkbox in front of **Please confirm...**

   - Click **Submit** button to start the reset.
   - The device is reset.
# 11 Technical Data

## 11.1 Technical Data EU5C-SWD-POWERLINK Gateway

<table>
<thead>
<tr>
<th>Category</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part number</strong></td>
<td>Part number</td>
<td>9233.920</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>(W x H x D)</td>
<td>35 x 90 x 127 mm</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Weight</td>
<td>160 g</td>
</tr>
<tr>
<td><strong>Mounting</strong></td>
<td>Mounting</td>
<td>Top hat rail 35 mm (IEC/EN 60715)</td>
</tr>
<tr>
<td><strong>Mounting position</strong></td>
<td>Mounting position</td>
<td>Vertical</td>
</tr>
<tr>
<td><strong>Standards</strong></td>
<td>Standards</td>
<td>IEC/EN 61131-2</td>
</tr>
<tr>
<td><strong>Communication controller</strong></td>
<td>Communication controller</td>
<td>netX 50 processor</td>
</tr>
<tr>
<td><strong>Configuration and diagnostic</strong></td>
<td>Configuration and diagnostic interface</td>
<td>Mini-USB</td>
</tr>
<tr>
<td><strong>Integrated memory</strong></td>
<td>Integrated memory</td>
<td>8 MB SDRAM</td>
</tr>
<tr>
<td><strong>Protection type</strong></td>
<td>Protection type</td>
<td>IP20</td>
</tr>
<tr>
<td><strong>Vibrations</strong></td>
<td>Vibrations</td>
<td>Constant amplitude 3.5 mm: 5 – 9 Hz</td>
</tr>
<tr>
<td><strong>Mechanical shock resistance</strong></td>
<td>Mechanical shock resistance</td>
<td>Semi-sinusoidal 15 g/11 ms: 9 Shocks</td>
</tr>
<tr>
<td><strong>Drop to</strong></td>
<td>Drop to</td>
<td>Drop height: 50 mm</td>
</tr>
<tr>
<td><strong>Free fall, packaged</strong></td>
<td>Free fall, packaged</td>
<td>Drop height: 1 m</td>
</tr>
<tr>
<td><strong>Operating ambient temperature</strong></td>
<td>Operating ambient temperature</td>
<td>-25…+55 °C</td>
</tr>
<tr>
<td><strong>Condensation</strong></td>
<td>Condensation</td>
<td>Prevent by suitable measures</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>Storage</td>
<td>-40…+70 °C</td>
</tr>
<tr>
<td><strong>Relative humidity, non-condensing</strong></td>
<td>Relative humidity, non-condensing</td>
<td>5…95 %</td>
</tr>
<tr>
<td><strong>Pollution degree</strong></td>
<td>Pollution degree</td>
<td>2</td>
</tr>
<tr>
<td><strong>Electrostatic discharge</strong></td>
<td>Electrostatic discharge</td>
<td>Air discharge (Level 3): 8 kV</td>
</tr>
<tr>
<td><strong>Electromagnetic fields</strong></td>
<td>Electromagnetic fields</td>
<td>Contact discharge (Level 2): 4 kV</td>
</tr>
<tr>
<td><strong>Radio interference suppression</strong></td>
<td>Radio interference suppression</td>
<td>EN 55011 Class A</td>
</tr>
<tr>
<td><strong>Burst</strong></td>
<td>Burst</td>
<td>Supply cables: 2 kV</td>
</tr>
<tr>
<td><strong>Surge</strong></td>
<td>Surge</td>
<td>Supply cables: 0.5 kV</td>
</tr>
<tr>
<td><strong>Radiated RFI</strong></td>
<td>Radiated RFI</td>
<td>0.15 – 80 MHz, 10 V, 80% AM / 1 KHz</td>
</tr>
</tbody>
</table>
### Technical Data

<table>
<thead>
<tr>
<th>Category</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supply voltage $U_{AUX}$</strong></td>
<td>Rated operational voltage</td>
<td>24 V DC -15 % +20 %</td>
</tr>
<tr>
<td></td>
<td>Input voltage residual ripple</td>
<td>≤ 5 %</td>
</tr>
<tr>
<td></td>
<td>Protection against polarity reversal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>max. current $I_{\text{max}}$</td>
<td>3 A  <strong>Note</strong>: If contactors with a total power consumption &gt; 3 A are connected, a power feeder module EU5C-SWD-PF1/2 has to be used.</td>
</tr>
<tr>
<td></td>
<td>Short-circuit strength</td>
<td>No, external fuse FAZ Z3</td>
</tr>
<tr>
<td></td>
<td>Heat dissipation</td>
<td>Typ. 1 W</td>
</tr>
<tr>
<td></td>
<td>Potential isolation</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Rated operating voltage of 24-V-DC slaves</td>
<td>Typical $U_{AUX}$ -0.2 V</td>
</tr>
</tbody>
</table>

| **Supply voltage $U_{POW}$** | Supply voltage | 24 V DC -15 % +20 % |
| | Input voltage residual ripple | ≤ 5 % |
| | Protection against polarity reversal | Yes |
| | Rated operational current $I$ | 111 mA (with two participants) |
| | Heat dissipation at 24 V DC | 2.66 W (with two participants) |
| | Potential isolation between $U_{POW}$ and 15-V-SmartWire-DT supply voltage | No |
| | Bridging voltage dips | 10 ms |
| | Repeat rate | 1 s |
| | Status display | $POW$ LED |

| **SmartWire-DT supply voltage** | Rated operational voltage $U_o$ | 15 V ± 3 % |
| | max. current $I_{\text{max}}$ | 0.7 A  **Note**: If contactors with a total power consumption > 0.7 A are connected, a power feeder module EU5C-SWD-PF2 has to be used. |
| | Short-circuit strength | Yes |

| **Connection supply voltages** | Connection type | Push-in terminals |
| | solid | 0.2 – 1.5 mm² (AWG 24 – 16) |
| | Flexible with ferrule | 0.25 – 1.5 mm² |

| **SmartWire-DT network** | Participant type | SmartWire-DT master |
| | SmartWire-DT Master ASIC | SWD-80P-RS485 |
| | Number of SmartWire-DT slaves | 99 |
| | Baud rate | 125 / 250 kBd |
| | Address setting | Automatic |
### Table 23: Technical Data EU5C-SWD-POWERLINK Gateway

<table>
<thead>
<tr>
<th>Category</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status display</td>
<td>SmartWire-DT master: <strong>SWD</strong> LED, duo color red/green</td>
<td>Configuration: <strong>Config</strong> LED, duo color red/green</td>
</tr>
<tr>
<td>Connections</td>
<td>Plug, 8-pole</td>
<td></td>
</tr>
<tr>
<td>Plug connectors</td>
<td>Blade terminal SWD4-8MF2</td>
<td></td>
</tr>
<tr>
<td>Ethernet POWERLINK network</td>
<td>Function of gateway</td>
<td><strong>POWERLINK</strong> Controlled Node (Slave)</td>
</tr>
<tr>
<td>Baud rate</td>
<td>100 MBit/s</td>
<td></td>
</tr>
<tr>
<td>Interface type</td>
<td>100 BASE-TX</td>
<td></td>
</tr>
<tr>
<td>Half duplex/full duplex</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>Auto-Negotiation</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>Auto-Crossover</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>Address setting</td>
<td>By project configuration</td>
<td></td>
</tr>
<tr>
<td>Status display</td>
<td><strong>POWERLINK</strong> Controlled Node: <strong>APL, BS, BE</strong> LEDs, duo color red/green</td>
<td>Connector socket: 2 x RJ45</td>
</tr>
<tr>
<td>Connector plug</td>
<td>RJ45</td>
<td></td>
</tr>
<tr>
<td>Potential isolation</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

### 11.2 Technical Data POWERLINK Controlled Node

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of cyclic input data</td>
<td>1490 bytes</td>
</tr>
<tr>
<td>Maximum number of cyclic output data</td>
<td>1490 bytes</td>
</tr>
<tr>
<td>Acyclic data transfer</td>
<td>SDO Upload/Download</td>
</tr>
<tr>
<td>Functions</td>
<td>SDO over ASND and UDP</td>
</tr>
<tr>
<td>Baud rate</td>
<td>100 MBit/s, half-duplex</td>
</tr>
<tr>
<td>Data transport layer</td>
<td>Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet POWERLINK version</td>
<td>V 2</td>
</tr>
<tr>
<td>Limitation</td>
<td>No slave to slave communication</td>
</tr>
<tr>
<td>Reference to firmware/stack version</td>
<td>V2.1.x.x</td>
</tr>
</tbody>
</table>

*Table 24: Technical Data POWERLINK Controlled Node (Slave) Protocol*
12 Annex

12.1 List of Figures

Figure 1: Data Flow EU5C-SWD-POWERLINK Gateway 21
Figure 2: Front View EU5C-SWD-POWERLINK Gateway 27
Figure 3: LEDs EU5C-SWD-POWERLINK Gateway 28
Figure 4: Pinning of the Ethernet Interface (RJ45) 31
Figure 5: Device Type Label EU5C-SWD-POWERLINK Gateway 32
Figure 6: Mounting Principle of the Gateway 35
Figure 7: Hook Gateway to Upper Railing 35
Figure 8: Hook Gateway to Lower Railing 36
Figure 9: Gateway is Clamped to Top Hat Rail 36
Figure 10: Unhook Gateway 37
Figure 11: Gateway Power Supply 39
Figure 12: Connecting SmartWire-DT to Gateway 40
Figure 13: Connecting POWERLINK to Gateway 41
Figure 14: SmartWire-DT Installation Wizard 45
Figure 15: Start Window of SWD-Assist 47
Figure 16: Communication View in SWD-Assist 48
Figure 17: Target Configuration in SWD-Assist 49
Figure 18: Planned Configuration in SWD-Assist: Set Device Parameters 50
Figure 19: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of Gateway 51
Figure 20: Planned Configuration in SWD-Assist 53
Figure 21: POWERLINK Project in Automation Studio 54
Figure 22: Select Controller Module Dialog in Automation Studio 55
Figure 23: Module Parameter Dialog in Automation Studio 55
Figure 24: Gateway in POWERLINK Project 56
Figure 25: Open I/O Mapping 56
Figure 26: I/O Mapping of SWD Slaves 57
Figure 27: Firmware Update via HTTP (as depicted in Internet Explorer) 64
Figure 28: Reset via HTTP (as depicted in Internet Explorer) 66
12.2 List of Tables

Table 1: List of Revisions 5
Table 2: Reference to Hardware and Firmware 7
Table 3: Reference to Software Tools 7
Table 4: Reference to Drivers 7
Table 5: Directory of DVD 9
Table 6: Documentation Overview 12
Table 7: Safety Symbols and Sort of Warning or Principle 20
Table 8: Signal Words 20
Table 9: Description of the LEDs (1) 29
Table 10: Description of the LEDs (2) 30
Table 11: Ethernet Interface Channel 0 and Channel 1 Pin Assignment (RJ45) 31
Table 12: Getting Started 33
Table 13: Elements Read Request SDO Write 58
Table 14: Example Read Request SDO Write 58
Table 15: Elements Write Request SDO Write 59
Table 16: Example Write Request SDO Write 59
Table 17: Elements SDO Read 60
Table 18: Example SDO Read 60
Table 19: Structure of Error Entry 61
Table 20: Diagnostic Messages 61
Table 21: Error Flags if Error Code = 0xFF00 61
Table 22: Controls in Firmware Update Page 65
Table 23: Technical Data EU5C-SWD-POWERLINK Gateway 69
Table 24: Technical Data POWERLINK Controlled Node (Slave) Protocol 69

12.3 Contact

Eaton
1000 Eaton Boulevard
Cleveland, OH 44122
United States
Eaton.com
We make what matters work.*

*At Eaton, we believe that power is a fundamental part of just about everything people do. Technology, transportation, energy and infrastructure—these are things the world relies on every day. That’s why Eaton is dedicated to helping our customers find new ways to manage electrical, hydraulic and mechanical power more efficiently, safely and sustainably. To improve people’s lives, the communities where we live and work, and the planet our future generations depend upon. Because that’s what really matters. And we’re here to make sure it works.

See more at Eaton.com/whatmatters